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1.

1.3 

Waste Electrical and Electronic Equipment-

WEEE

This marking on the product or on its packaging 

illustrates that, under European Directive 2002/96/

EC governing used electrical and electronic 

appliances, this product may not be disposed 

of with normal household waste. You are 

responsible for disposal of this equipment through 

a designated waste electrical and electronic 

equipment collection. To determine the locations 

for dropping off such waste electrical and 

electronic, contact your local government office, 

the waste disposal organization that serves your 

household or the store at which you purchased 

the product.

Your new monitor contains materials that can be 

recycled and reused. Specialized companies can 

recycle your product to increase the amount of 

reusable materials and to minimize the amount to 

be disposed of. 

All redundant packing material has been omitted. 

We have done our utmost to make the packaging 

easily separable into mono materials.

Please find out about the local regulations on how 

to dispose of your old monitor and packing from 

your sales representative. 

Recycling Information for Customers

Your display is manufactured with high quality 

materials and components which can be recycled 

and reused. 

To learn more about our recycling program please 

visit www.philips.com/about/sustainability/recycling.



4

2.

2. 

2.1 
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2.

 

 

 VGA 

 DVI-D 

 Kensington 

   

 PC

1. 

2. 

3. 

4. 

5. 

2.2 

 

220V3/220V3L

5

6 27 14 3

220V3A/220V3LA

5
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 OSD 

 OSD

 OSD 
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2.

 OSD

OSD ?

On-Screen Display OSD

220V3/220V3L

220V3A/220V3LA

 OSD 

    OK

OSD 

 OSD 
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2.

 

 1680 × 

1050 @ 60Hz 

 1680 × 1050 @ 60Hz

 Setup
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3.

3. 

3.1 SmartContrast

 

 

SmartContrast 

 

 

 SmartContrast 

3.2 Philips SmartControl Lite

Phillips  SmartControl Lite 

/ RGB 

 Windows 7 

 Philips 

!

 

• 

• 

• 
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3.

Wizard

 SmartControl Lite • 

 Wizard

• 

 Plug-in• 

 Standard• 

 

Adjust

 Ad ju s t• 

 Brightness Contrast

Focus Position

 Resolution

• 

Cancel• 
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3.

Color

 Co l o r  • 

RGB Black Level White 

Point Display Gamma

Color Calibration

 SmartImage Lite  SmartImage 

Lite 

• 

• 

Color Calibration• 
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3.

1. Show Me

Start2. -  6 

Quick View3. /

 Color4. 

 Cancel

 - 5. 

6. 

• Prev ious

Next• 6 

Final next•  File > Presets

 > 

Cancel• 
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3.

Options>Preferences > -  

Options  Preferences

 DDC/CI  Help  

Options

• 

• 

• 

 Enable Context Menu

Enable Context Menu

 SmartControl Lite  Select Preset

 Tune Display

 

SmartControl Lite

 • On Enable 

Task Tray Enable 

context menu  

Smar tControl Lite 

Help

Technical Suppor t

Check for Upgrade

About  Exit

 Enable task tray menu

 Exit

 • On Run 

at Star tup

SmartControl Lite 

 SmartControl Lite 

Enable transparency mode• 

Windows 7/Vista/XP  0% 

Options > Input  > - 

Options  Input

 DDC/

CI  Help  Options

 SmartControl Lite 

 Source• 

• 
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3.

Options > Audio  > -  

Options  Audio

 DDC/CI  

Help  Option

Help > User Manual  > - 

 Help  User Manual

 DDC/CI  Help  

Options

Help > Version  > -  Help

 Version

 DDC/CI

 Help  Options

Context Sensitive Menu

 Opt ions > 

Preferences  > 

Enable Context Menu
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3.

 4 

SmartControl Lite -  • About

Select Preset• - 

Tu n e  D i s p l a y -   • 

SmartControl Lite 

SmartImage Lite – Standard• 

Internet Game

 SmartControl Lite 

 5 

Help• -  User Manual

 

User Manual

Technical Support - • 

Check for Update• - 

 PDI 

About - • 

Exit –  SmartControl Lite• 

 Smar tControl Lite

Program  Smar tControl 

Lite  PC 

 EXIT

 SmartControl Lite  Options > 

Preferences  >  Run at 

Startup

 

Smar tControl 

 Portrait  www.portrait.com/

dtune/phl/enu/index  SmartControl 
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4.

4. 

/

TFT-LCD

CCFL 220V3/220V3A LED 220V3L/220V3LA

22" 55.9 cm

16:10

0.282 x 0.282 mm

250 cd/m²

SmartContrast 10,000,000:1

1,000:1

5 ms

1680 x 1050 @ 60Hz

160 H / 160 V @ C/R > 10

1670 

56Hz -76Hz

30kHz - 83kHz

sRGB

DVI-D VGA

220V3/220V3L

220V3A/220V3LA

OSD 

Kensington 

DDC/CI sRGB Windows 7 Mac OSX Linux

 -5/+20 
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4.

220V3

22.63W 26.51W

 

EnergyStar 5.0  100VAC +/- 

5VAC  

50Hz +/-5Hz

 115VAC +/- 

5VAC  

50Hz +/-5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

20.61W 20.41W 19.85W

0.5W 0.5W 0.5W

0.5W 0.5W 0.5W

*

 100VAC +/- 

5VAC  

50Hz +/ -5Hz

 115VAC +/- 

5VAC  

50Hz +/ -5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

70.35 BTU/hr 69.67 BTU/hr 67.75 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

 LED /

100-240VAC 50-60Hz

220V3A

21.41W 31.9W

 

EnergyStar 5.0  100VAC +/- 

5VAC  

50Hz +/-5Hz

 115VAC +/- 

5VAC  

50Hz +/-5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

20.00W 19.79W 19.50W

0.5W 0.5W 0.5W

0.5W 0.5W 0.5W

*

 100VAC +/- 

5VAC  

50Hz +/ -5Hz

 115VAC +/- 

5VAC  

50Hz +/ -5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

68.25 BTU/hr 67.54 BTU/hr 66.55 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

 LED /

100-240VAC 50-60Hz
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4.

220V3L

19.59W 24.15W

 

EnergyStar 5.0  100VAC +/- 

5VAC  

50Hz +/-5Hz

 115VAC +/- 

5VAC  

50Hz +/-5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

16.72W 16.49W 16.24W

0.5W 0.5W 0.5W

0.5W 0.5W 0.5W

*

 100VAC +/- 

5VAC  

50Hz +/ -5Hz

 115VAC +/- 

5VAC  

50Hz +/ -5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

57.08 BTU/hr 56.26 BTU/hr 55.42 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

 LED /

100-240VAC 50-60Hz

220V3LA

18.54W 28.03W

 

EnergyStar 5.0  100VAC +/- 

5VAC  

50Hz +/-5Hz

 115VAC +/- 

5VAC  

50Hz +/-5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

16.33W 16.19W 16.05W

0.5W 0.5W 0.5W

0.5W 0.5W 0.5W

*

 100VAC +/- 

5VAC  

50Hz +/ -5Hz

 115VAC +/- 

5VAC  

50Hz +/ -5Hz

 230VAC +/- 

5VAC  

50Hz +/ -5Hz

55.72 BTU/hr 55.26 BTU/hr 54.79 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

1.706 BTU/hr 1.706 BTU/hr 1.706 BTU/hr

 LED /

100-240VAC 50-60Hz
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4.

WxHxD 530 x 425 x 213 mm

WxHxD

530 x 364 x 53 mm

3.81 kg 

3.51 kg

4.32 kg

0˚C  40˚C

-20˚C  60˚C

20%  80%

+ 12,000 3,658 m

+ 40,000 12,192 m

MTBF 30,000 

ROHS 

EPEAT Silver www.epeat.net

EnergyStar 5.0

100% 

 PVC BFR 

CE Mark FCC Class B GOAST SEMKO TCO Certified

UL/cUL BSMI ISO9241-307 Energy star 5.0

/

 

EPEAT Gold  Sliver  Philips 1. 

 www.epeat.net

 2. www.philips.com/support 
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4.

4.1 

 

 1680 x 1050 @ 60 Hz

 1680 x 1050 @ 60 Hz

 

 1680 x 1050 @ 60 Hz

kHz

  

Hz

31.469 640x350 70.086

31.469 720x400 70.086

31.469 640x480 59.940

35.000 640x480 67.000

37.500 640x480 75.000

35.156 800x600 56.250

37.879 800x600 60.317

46.875 800x600 75.000

48.363 1024x768 60.004

60.023 1024x768 75.029

63.981 1280x1024 60.020

79.976 1280x1024 75.025

55.469 1440x900 59.901

55.935 1440x900 59.887

70.635 1440x900 74.984

65.290 1680x1050 60.000

82.306 1680x1050 74.892

 

 1680 x 1050 @ 60Hz 
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5. 电源管理

5. 电源管理

5.1 自动省电

如果 PC 中安装了 VESA DPM 兼容显示卡或
者软件，显示器可以在不使用时自动降低功
耗。如果检测到来自键盘、鼠标或其它输入
设备的输入，显示器将自动“唤醒”。下表

介绍此自动省电功能的功耗和信号时序：

220V3

电源管理定义
VESA 模式 视频 水平 

同步
垂直
同步

使用的功率 LED 颜色 

工作 开启 是 是 < 22.63 W（典型）
< 26.51 W（最大）

白色

睡眠 
（待机）

关闭 否 否 < 0.5 W（典型） 白色 
（闪烁）

关闭 关闭 - - < 0.5 W（典型） 关闭

220V3A

电源管理定义
VESA 模式 视频 水平 

同步
垂直
同步

使用的功率 LED 颜色 

工作 开启 是 是 < 21.41 W（典型）
< 31.9 W（最大）

白色

睡眠 
（待机）

关闭 否 否 < 0.5 W（典型） 白色 
（闪烁）

关闭 关闭 - - < 0.5 W（典型） 关闭

220V3L

电源管理定义
VESA 模式 视频 水平 

同步
垂直
同步

使用的功率 LED 颜色 

工作 开启 是 是 < 19.59 W（典型）
< 24.15 W（最大）

白色

睡眠 
（待机）

关闭 否 否 < 0.5 W（典型） 白色 
（闪烁）

关闭 关闭 - - < 0.5 W（典型） 关闭

220V3LA

电源管理定义
VESA 模式 视频 水平 

同步
垂直
同步

使用的功率 LED 颜色 

工作 开启 是 是 < 18.54 W（典型）
< 28.03 W（最大）

白色

睡眠 
（待机）

关闭 否 否 < 0.5 W（典型） 白色 
（闪烁）

关闭 关闭 - - < 0.5 W（典型） 关闭

下面的设置用于测量此显示器的功耗。

固有分辨率：1680 x 1050
对比度：50%
亮度：250 尼特
色温：6500k 全白图案

 注
此数据如有变更，恕不另行通知。
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6.

6. 

Lead-free Product

Lead free display promotes 

environmentally sound recovery and 

disposal of waste from electrical and 

electronic equipment. Toxic substances 

like Lead has been eliminated and compliance with 

European community’s stringent RoHs directive 

mandating restrictions on hazardous substances 

in electrical and electronic equipment have been 

adhered to in order to make Philips monitors safe 

to use throughout its life cycle.

Congratulations, 

Your display is designed for both you and the 

planet!

The display you have just purchased 

carries the TCO Certified label. This 

ensures that your display is 

designed, manufactured and tested 

according to some of the strictest quality and 

environmental requirements in the world. This 

makes for a high performance product, designed 

with the user in focus that also minimizes the 

impact on the climate and our natural 

environment. 

TCO Certified is a third party verified program, 

where every product model is tested by an 

accredited impartial test laboratory. TCO Certified 

represents one of the toughest certifications for 

displays worldwide.

Some of the Usability features of the TCO 

Certified for displays:

 Visual ergonomics for good image quality is  •

tested to ensure top performance and reduce 

sight and strain problems. Important parameters 

are luminance, contrast, resolution, black level, 

gamma curve, colour and luminance uniformity 

and colour rendering 

 Products are tested according to rigorous safety  •

standards at impartial laboratories

 Electric and magnetic fields emissions as low as  •

normal household background levels

Low acoustic noise emissions (when applicable) •

Some of the Environmental features of the TCO 

Certified for displays:

 The brand owner demonstrates corporate  •

social responsibility and has a certified 

environmental management system (EMAS or 

ISO 14001)

 Very low energy consumption both in on- and  •

standby mode minimize climate impact

 Restrictions on chlorinated and brominated  •

flame retardants, plasticizers, plastics and heavy 

metals such as cadmium, mercury and lead 

(RoHS compliance)

 Both product and product packaging is prepared  •

for recycling

 The brand owner offers take-back options •

The requirements can be downloaded from our 

web site. The requirements included in this label 

have been developed by TCO Development in 

co-operation with scientists, experts, users as well 

as manufacturers all over the world. Since the end 

of the 1980s TCO has been involved in influencing 

the development of IT equipment in a more user-

friendly direction. Our labeling system started with 

displays in 1992 and is now requested by users 

and ITmanufacturers all over the world. About 

50% of all displays worldwide are TCO certified.

For more information, please visit

www.tcodevelopment.com

For displays with glossy bezels the user should 

consider the placement of the display as the bezel 

may cause disturbing reflections from surrounding 

light and bright surfaces.
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6.

EPEAT 
(www.epeat.net)

“The EPEAT (Electronic Product 

Environmental Assessment Tool) 

program evaluates computer 

desktops, laptops, and monitors 

based on 51 environmental criteria developed 

through an extensive stakeholder consensus 

process supported by US EPA.

EPEAT system helps purchasers in the public 

and private sectors evaluate, compare and select 

desktop computers, notebooks and monitors 

based on their environmental attributes. EPEAT 

also provides a clear and consistent set of 

performance criteria for the design of products, 

and provides an opportunity for manufacturers to 

secure market recognition for efforts to reduce 

the environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 

requirement that all registered products meet 

ENERGY STAR’s energy efficiency specifications, 

means that these products will consume less 

energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following 

standards 

EN60950-1:2006 (Safety requirement of • 

Information Technology Equipment) 

EN55022:2006 (Radio Disturbance • 

requirement of Information Technology 

Equipment) 

EN55024:1998+A1:2001+A2:2003 (Immunity • 

requirement of Information Technology 

Equipment) 

EN61000-3-2:2006 (Limits for Harmonic • 

Current Emission) 

EN61000-3-3:1995+A1:2001+A2:2005 • 

(Limitation of Voltage Fluctuation and Flicker) 

following provisions of directives applicable

2006/95/EC (Low Voltage Directive) • 

2004/108/EC (EMC Directive) • 

2005/32/EC (EuP Directive, EC No. 1275/2008 • 

mplementing Directive for Standby and Off 

mode power consumption) and is produced by 

a manufacturing organization on ISO9000 level.  

 The product also comply with the following 

standards 

ISO9241-307:2008 (Ergonomic requirement, • 

Analysis and compliance test methods for 

electronic visual displays) 

GS EK1-2000:2009 (GS mark requirement)• 

prEN50279:1998 (Low Frequency Electric and • 

Magnetic fields for Visual Display) 

MPR-II (MPR:1990:8/1990:10 Low Frequency • 

Electric and Magnetic fields) 

 TCO certified (Requirement for Environment  •

Labeling of Ergonomics, Energy,  Ecology and 

Emission, TCO: Swedish Confederation of 

Professional Employees) for TCO versions

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we 

have determined that this product 

meets the ENERGY STAR® guidelines 

for energy efficiency.

  Note

We recommend you switch off the monitor when 

it is not in use for a long time.
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6.

Federal Communications Commission (FCC) 

Notice (U.S. Only)

  This equipment has been tested and found 

to comply with the limits for a Class B digital 

device, pursuant to Part 15 of the FCC 

Rules. These limits are designed to provide 

reasonable protection against harmful 

interference in a residential installation. This 

equipment generates, uses and can radiate 

radio frequency energy and, if not installed 

and used in accordance with the instructions, 

may cause harmful interference to radio 

communications. However, there is no 

guarantee that interference will not occur 

in a particular installation. If this equipment 

does cause harmful interference to radio or 

television reception, which can be determined 

by turning the equipment off and on, the 

user is encouraged to try to correct the 

interference by one or more of the following 

measures:

Reorient or relocate the receiving antenna. • 

Increase the separation between the • 

equipment and receiver. 

Connect the equipment into an outlet on • 

a circuit different from that to which the 

receiver is connected. 

Consult the dealer or an experienced radio/• 

TV technician for help.

  Changes or modifications not expressly 

approved by the party responsible for 

compliance could void the user's authority to 

operate the equipment.

Use only RF shielded cable that was supplied with 

the monitor when connecting this monitor to a 

computer device. 

To prevent damage which may result in fire or 

shock hazard, do not expose this appliance to rain 

or excessive moisture. 

THIS CLASS B DIGITAL APPARATUS MEETS 

ALL REQUIREMENTS OF THE CANADIAN 

INTERFERENCE-CAUSING EQUIPMENT 

REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 

with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 

Rules. Operation is subject to the following two 

conditions: (1) this device may not cause harmful 

interference, and (2) this device must accept any 

interference received, including interference that 

may cause undesired operation. 
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6.

Commission Federale de la Communication 

(FCC Declaration)

  Cet équipement a été testé et déclaré 

conforme auxlimites des appareils numériques 

de class B,aux termes de l'article 15 Des 

règles de la FCC. Ces limites sont conçues 

de façon à fourir une protection raisonnable 

contre les interférences nuisibles dans le cadre 

d'une installation résidentielle. 

  CET appareil produit, utilise et peut émettre 

des hyperfréquences qui, si l'appareil n'est pas 

installé et utilisé selon les consignes données, 

peuvent causer des interférences nuisibles aux 

communications radio. 

  Cependant, rien ne peut garantir l'absence 

d'interférences dans le cadre d'une installation 

particulière. Si cet appareil est la cause 

d'interférences nuisibles pour la réception des 

signaux de radio ou de télévision, ce qui peut 

être décelé en fermant l'équipement, puis en 

le remettant en fonction, l'utilisateur pourrait 

essayer de corriger la situation en prenant les 

mesures suivantes:

•  Réorienter ou déplacer l'antenne de réception. 

•  Augmenter la distance entre l'équipement et 

le récepteur. 

•  Brancher l'équipement sur un autre circuit que 

celui utilisé par le récepteur. 

•  Demander l'aide du marchand ou d'un 

technicien chevronné en radio/télévision.

  Toutes modifications n'ayant pas reçu 

l'approbation des services compétents 

en matière de conformité est susceptible 

d'interdire à l'utilisateur l'usage du présent 

équipement.

N'utiliser que des câbles RF armés pour 

les connections avec des ordinateurs ou 

périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 

B RESPECTE TOUTES LES EXIGENCES DU 

REGLEMENT SUR LE MATERIEL BROUILLEUR 

DU CANADA.

EN 55022 Compliance (Czech Republic Only)
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6.

Polish Center for Testing and Certification 

Notice

The equipment should draw power from a socket 

with an attached protection circuit (a three-

prong socket). All equipment that works together 

(computer, monitor, printer, and so on) should 

have the same power supply source.

The phasing conductor of the room's electrical 

installation should have a reserve short-circuit 

protection device in the form of a fuse with a 

nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 

power supply cable must be removed from the 

power supply socket, which should be located 

near the equipment and easily accessible.

A protection mark "B" confirms that the 

equipment is in compliance with the protection 

usage requirements of standards PN-93/T-42107 

and PN-89/E-06251.

North Europe (Nordic Countries) Information

Placering/Ventilation 

VARNING:

FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 

OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR DU 

STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 

SØRG VED PLACERINGEN FOR, AT 
NETLEDNINGENS STIK OG STIKKONTAKT ER 
NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 

SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)



27

6.

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den 

in der "Verordnung über den Schutz vor Schäden 

durch Röntgenstrahlen" festgelegten Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 

ein Aufkleber, der auf die Unbedenklichkeit der 

Inbetriebnahme hinweist, da die Vorschriften über 

die Bauart von Störstrahlern nach Anlage III ¤ 5 

Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 

geforderten Werten entspricht, ist darauf zu 

achten, daß 

Reparaturen nur durch Fachpersonal 1. 

durchgeführt werden. 

nur original-Ersatzteile verwendet werden. 2. 

bei Ersatz der Bildröhre nur eine bauartgleiche 3. 

eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf dunklem 
Untergrund zu verwenden (schlechte Lesbarkeit 
und erhöhte Augenbelastung bei zu geringem 
Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel nach 
DIN 45 635 beträgt 70dB (A) oder weniger. 

ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 

China RoHS 

The People's Republic of China released a 

regulation called "Management Methods for 

Controlling Pollution by Electronic Information 

Products" or commonly referred to as China 

RoHS. All products are produced and sold for 

China market have to meet China RoHS request.

 Note

Above regulation certificate might only be applied 

for selective models.
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7.

 www.philips.com/support 

/ ASC

Austria Siemens I&S +43 0810 000206 € 0.07

Belgium E Care +32 078 250851 € 0.06

Denmark A-novo +45 3525 8761 Local call tariff

Finland A-novo +358 09 2290 1908 Local call tariff

France A-novo +33 082161 1658 € 0.09

Germany Siemens I&S +49 01803 386 853 € 0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge

Ireland Invec Scotland +353 01 601 1161 Local call tariff

Italy A-novo +39 840 320 041 € 0.08

Luxembourg E Care +352 26 84 30 00 Local call tariff

Netherlands E Care +31 0900 0400 063 € 0.10

Norway A-novo +47 2270 8250 Local call tariff

Poland Zolter +48 0223491505 Local call tariff

Portugal Eatsa Spain +351 2 1359 1440 Local call tariff

Switzerland A-novo +41 02 2310 2116 Local call tariff

Spain Eatsa Spain +34 902 888 785 € 0.10

Sweden A-novo +46 08 632 0016 Local call tariff

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff

7.2 
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7.

/ ASC

Belarus NA IBA +375 17 217 3386

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA Renoprom +385 1 333 0974

Czech Rep. NA Asupport 800 100 697

Estonia NA FUJITSU +372 6519900

Hungary
NA Serware +36 1 2426331 

NA Profi Service +36 1 814 8080

Latvia NA ServiceNet LV  Ltd. +371 7460399

Lithuania NA UAB "Servicenet" +370 7400088

Romania NA Blue Ridge Intl. +40 21 2101969

Russia
NA CPS +7 (495) 645 6746 (for repair)

NA CEEE Partners +7 (495) 645 3010 (for sales)

Serbia & 

Montenegro
NA Kim Tec d.o.o. +381 11 20 70 684

Slovakia NA Datalan Service +421 2 49207155

Slovenia NA PC H.and +386 1 530 08 24

Ukraine
NA Comel +380 562320045 

NA Topaz-Service Company +38 044 245 73 31

Turkey NA Techpro +90 212 444 4 832 

/

Argentina Vermont 0800 3330 856

Brazil Vermont 0800-7254101

/ ASC

Canada Supercom Supercom (800) 479-6696

U.S.A. TOS Teleplan (877) 835-1838

4008 800 008
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7.

APMEA 

Country ASC

Australia NA AGOS NETWORK PTY LTD 1300 360 386

Bangladesh NA
Distributor: Computer Source 

Ltd (warranty buy-out)

880-2-9141747, 9127592 

880-2-8128848 / 52

Cambodia NA

Distributor: Neat Technology 

Pte Ltd (Singapore) (warranty 

buy-out)

855-023-999992

Hong Kong / 

Macau
NA Smart Pixels Technology Ltd.

Hong Kong:Tel: +852 2619 9639 

Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396 

SMS: PHILIPS to 56677 

Indonesia NA PT. Gadingsari elektronika Prima
Tel: 62 21 75909053, 75909056, 

7511530

Israel NA Eastronics LTD 1-800-567000

Malaysia NA
After Market Solutions (CE) 

Sdn Bhd
603 7953 3370

Nepal NA
Distributor: Syakar Co. Ltd 

(warranty buy-out)
977-1-4222395 

New Zealand NA Visual Group Ltd. 0800 657447

Pakistan NA Philips Consumer Service (9221) 2737411-16

Philippines NA Glee Electronics, Inc. 
(02) 633-4533 to 34, 

(02) 637-6559 to 60

Singapore NA

Philips Electronics Singapore 

Pte Ltd (Philips Consumer Care 

Center)

(65) 6882 3999

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888 

South Korea NA PCS One Korea Ltd. 080-600-6600

Sri Lanka NA
no distributor and/or service 

provider currently

Taiwan

PCCW 

Teleservices 

Taiwan 

FETEC.CO 0800-231-099

Thailand NA Axis Computer System Co., Ltd. (662) 934-5498

United Arab 

Emirates
NA AL SHAHD COMPUTER L.L.C 00971 4 2276525

Vietnam NA
FPT Service Informatic 

Company Ltd.

+84 8 38248007 Ho Chi Minh City 

+84 5113.562666 Danang City 

+84 5113.562666 Can tho Province
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8.2 SmartControl Lite 
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8.3 
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